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Chapter 1
Introduction
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Over view
This is a synopsis of the DAS™ Data Acquisition Suite and its various features.

1.1 Introduction
MREL’s DAS™ Data Acquisition Suite has been designed to be utilized with MREL VOD/Data recorders. This software suite will allow the
user to program (where applicable), download and analyze the data from each recorder. The DAS™ Data Acquisition Suite will allow the
user to manage all of the files downloaded from MREL VOD/Data recorders using a single software.
The Standard Edition will allow the user to open data files from any of the three recorders. The user can perform all of the standard
features that the users have been accustom to. For a VOD channel, the measurements that a user can do are as follows:
•

Measure Velocity of Detonation

•

Borehole or Sample

•

Measure Column Height

•

Measure Booster Location

•

Measure Time Delay Between Holes

•

Measure Effectiveness of Decking

NOTE: Some of the features discussed in this
manual are available in DAS™ version later
than 1.0.0.0. Please check for any available
updates in DAS™.

For a Scope channel, the measurements that a user can do are as follows:
•

Analyze DC Voltage Data

•

Apply Offsets

•

Measure Values of Peaks

•

Measure Time Between Peaks

•

Apply Formulas to Convert Voltage to Engineering Units

For a Strain channel, the measurements that a user can do is as follows:
•

Convert the data from the strain gauges into Microstrain (μE)

The Advanced Edition will allow the user to apply filters to the data to either clean the data up for ease of reading/presentation or to
apply a specific filter to allow the data to be compliant with a particular standard. Some additional operations such as curve fitting and
integration are available.
The Advanced Edition can perform all of the Standard Edition features plus the following to a channel data:
•

•

Apply the following filters to the data
•

Bessel

•

Median

•

Miscellaneous Filters

•

Butterworth

•

Moving Average

•

Negative Distance Removal

•

Chebyshev

•

Savitzky-Golay

•

Elliptic

•

Windowed Finite Impulse Response

(VOD channel only)

Apply the following operations to one (or two) selected plot/s
•

Curve Fitting (Polynomial, Exponential, Linear, Gaussian etc.)

•

Normalize, Scale, Quick Scale, Clip

•

Differentiation and Integration

•

AC/DC Estimation, Statistics

•

Area under the curve

•

Add, Subtract, Multiply, Divide (all 2-plot operations)

See Section 8 for more details on the Advanced Edition. The software can be downloaded from www.mrel.com/das at any time.
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Over view
This section will step the user through the installation procedure on their computer.

2.1 System Requirements
The minimum system requirements for DAS™ Data Acquisition Suite are as follows:
•

32-bit/64-bit CPU: AMD/Intel

•

Memory: 2 GB

•

Hard disk space: 1 GB, more space is required for large number of files.

•

Ports: USB port (internal or powered)

•

Monitor resolution: 1200 x 800

•

Operating system: Windows XP (SP3) or above (32 or 64 bit)

•

Full .NET 4 framework

Administrative type of user account and Internet connection required for registration, upgrades, updates and support. The software can
be used offline when not performing any of the previous tasks.

2.2 Recommended System Requirements
The recommended system requirements for DAS™ Data Acquisition Suite are as follows:
•

64-bit CPU: AMD/Intel

•

Memory: 8 GB or more

•

Hard disk space: 25 GB or more

•

Ports: USB 2.0 or 3.0 port (internal or powered)

•

Monitor resolution: 1200 x 800 or more

•

Operating system: Windows 7 or above (64-bit)

•

Any suitable mail client program such as Microsoft Outlook, Mozilla Thunderbird etc.

•

Full .NET 4.5 or above framework

•

Administrative type of user account and Internet connection required for registration, upgrades, updates and support. The software
can be used offline when not performing any of the previous tasks.

2.3 Prerequisites Installation Process
The DAS™ Data Acquisition Suite setup will display a message if necessary prerequisites from internet are needed to be installed first. It
will direct user to the correct download page if computer is connected to the internet. If not connected, it will show the error page in the
computer’s default web browser.
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2.3.1 .NET Framework 4.0 Installation Process (if required)
Double click on the DAS™ Data Acquisition Suite install package
(.msi) file or Right-Click on the file and choose install. You need to be
using administrative type of user account on the computer to perform
the installation.
If setup program has detected that the .NET Framework 4.0 is not
installed, it will show the message as shown on the right.

If the computer is connected to the internet and user chooses Yes in
above dialog, the default web browser is opened showing the .NET
Framework 4.0 Full package download page.
Click the Download button to download .NET Framework 4.0 setup.

The optional components suggested by the page can be ignored by
clicking No thanks and continue button as shown to the right.
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Click the blocked pop-up tool-bar (if pop-up is blocked by browser)
and select Download File... option as shown to the right.

Save the file in a desired temporary location as shown to the right.

Double click the downloaded file (.exe file) to install .NET
Framework 4.0 shown to the right.
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Click the Yes button in UAC “User Account Control” dialog shown
to the right.

The package will uncompress and shows the initial Microsoft .NET
Framework 4 license Agreement dialog. Check Accept check box
and click Install button as shown to the right.

When Installation finishes with success, you can proceed to run the
installation package for DAS™ Data Acquisition Suite as described
in the following section.

2.4 Installation Process
The installation package can be obtained at http://www.mrel.com/das
and locally save it if you have either not received copy or have misplaced it.

2.4.1 Installation Process for Windows Vista®
		and Higher

I M P O R TA N T
MREL recommends exiting all programs before
starting installation.
Double click on the DAS™ Data Acquisition Suite setup package
(.msi) or Right-Click on the file and choose install. You need to be
using an administrative type of account on the computer to perform
the installation. The installation dialog will appear with License
Agreement as shown to the right.
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Click I Agree and click on Next. This will display the image to the
right.

Click the Next button to confirm the installation process to begin.
This will results in the following screen.

Click the Next button which results in the following User Account
Control (UAC) dialog for Windows 7® or above.
Click YES to proceed.
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In Windows Vista®, the User Account Control (UAC) dialog may
look like the image shown to the right. Click Allow to proceed

Installation process will begin and the image to the right will be
shown.

Click the YES button to install the needed drivers.
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Make sure to check the HandiTrap II™ USB Interface Cable driver’s
manufacturer’s trust check box and click the Install button to install
the needed drivers as shown right.
Follow the same procedure if MicroTrap™ USB Interface Cable
driver installation message is displayed.

For DataTrap II™ USB Interface Cable driver installation, check the
driver’s manufacturer’s trust check box and click the Install button
to install the needed drivers as follows.

Click OK to the following message box which shows the drivers
installation was successful. Click Close to complete the installation.
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Click Yes to restart the system to complete the installation (this is
recommended) in the image shown right.
System will restart to complete the installation.

If you clicked No so as not to restart the system, click Close to
complete the installation.

The DAS™ Data Acquisition Suite has been successfully installed.
A program group MREL with the folder DAS™ will be created in
Start > All Programs menu. Also a shortcut named DAS™ Data
Acquisition Suite is created on the desktop as show to the right.

2.5 Drivers Files Location for Manual Installation
In some instances such as Windows XP®, when the USB cable
for MREL recorders is connected for the first time, the Found New
Hardware dialog box asks for driver location. All driver installation
files reside in their respective folder under DAS™ installation
directory which is installed on the Windows operating system’s
“Program Files” location as shown to the right.
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Just point the Found New Hardware dialog to search in folders dt2-drivers, ht2-drivers or mt-drivers for HandiTrap II™, MicroTrap™ and
DataTrap II™ USB Cables respectively.

2.6 Uninstallation of DAS™ Data Acquisition Suite

I M P O R TA N T
To uninstall the software, you need to use an administrative type of user account on the computer.

2.6.1 Uninstallation Process
Uninstalling DAS™ Data Acquisition Suite on supported version of
Windows® Operating Systems is similar.
To uninstall DAS™ Data Acquisition Suite, click Control Panel panel
in Start. The control panel is displayed as follows.

Click Programs and Feature icon in Control Panel which displays a
screen shown as to the right.

Select MREL Data Acquisition Suite in the list and Double-Click it.
This shows the image on the right.
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Click Yes button to the dialog asking Are you sure you want to
uninstall MREL Data Acquisition Suite? which shows the Preparing to
remove status dialog.

Click Yes button in UAC (User Account Control) dialog as shown to
the right.

In Windows Vista®, the UAC dialog box will look like the image
shown to the right. Click Allow to proceed

Uninstall will show a progress dialog box similar to the image to the
right.
Once the progress dialog box completes, the DAS™ Data
Acquisition Suite will be successfully uninstalled. However, your
data and related settings will still be present.
You can now close Programs and Features dialog and the Control
Panel itself.
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2.7 Software Registration
DAS™ always installs as Evaluation version. With the DAS™ Data Acquisition Suite software installed, the lower right-hand corner will
display Evaluation Edition, Unregistered.
The Evaluation edition allows the user to evaluate the software for 30 days (one-time) on a given computer. After evaluation period
expires, the user will need to either register the software or uninstall the DAS™ Data Acquisition Suite Software. Registration is required to
upgrade DAS™ to Standard Edition (FREE) or Advanced Edition (Paid). The user has to apply upgrade key after registration to complete
the process.
The user can at any time click on the Help tab in ribbon menu and then on Register in the tab or use top menu Help >
Register/Upgrade. The registration (and upgrade) requires an administrative type of user account and internet access. After DAS™ asks
to be restarted, it will display registration dialog. The user will fill in the required fields (red-coloured) such as First Name, Last Name,
Company Name, City, Country, Email and Industry. Any required field having invalid data will be flagged by red exclamation icon next
to it. After all required fields are filled, user will click the Register button. After successful processing, the software will be registered and
display a success message. Click OK to close that message.
At this point, the lower right corner of the software will display Evaluation Edition, Registered.
An email will be sent to the email address provided while registering and will include the Standard Edition upgrade Key for the computer.
When the email arrives, the user will click on Help and then Register/Upgrade… menu item, displaying the registration dialog. At the
bottom of the form is Upgrade checkbox. Check mark that and Install/Upgrade Type drop-down menu is now enabled. Select Standard
Edition in this drop-down menu and a text box will appear for the input of the upgrade key. Copy and paste the key (as is) from the email
into the text box and click Upgrade button. After successful processing, the displayed text on status bar on lower-right will change to
Standard Edition, Registered. Close DAS™ and run it again. At this point, the software is registered/upgraded successfully and will not
expire on the computer until uninstalled. The software is available to all users who have account on the computer. Only one user must run
DAS™ at a given time. The users have their own default data area under My Documents\MREL\Data.
Note that registered DAS™ will expire until the upgrade key is applied. The software will stop normal function and will only allow
registration/upgrade after 30 days of installation.
To upgrade to the Advanced Edition, refer to Chapter 8.

2.8 Updating DAS™
Updating to new version of DAS™ software requires that lower version of DAS™ exists on the machine. DAS™ must be registered and
upgraded to either Standard Edition or Advanced Edition. Evaluation version of DAS™ can not be upgraded to newer version.

Update Process:
Check for updates from within DAS™ by clicking on Help > Updates...
If an updated version of DAS™ software exists, it will be offered to be downloaded.
Download the software (a compressed (.zip) file) and save in a local temporary folder where you can later extract it.
After download is complete, Exit DAS™ and extract downloaded file. Double-click to run the extracted file. Follow prompt.
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Over view
This Chapter describes the starting process for the DAS™ Data Acquisition Suite.

3.1 Starting the DAS™ Data Acquisition Suite
Double click on the DAS™ Data Acquisition Suite desktop icon.
Alternatively access the program through the Start Menu.
Start > All Programs > MREL > DAS > DAS™ Data Acquisition Suite.
The following splash screen will show up.

When DAS™ Data Acquisition Suite completes loading, the splash
screen fades away to show the main screen as shown to the right.
After the initial screen is displayed, the DAS™ Data Acquisition
Suite may check and update the main display for any connected
MREL Data or VOD recorders and any tests stored if any.

Note:

The message box to the right is displayed for a short period of time

		

upon starting the software. The software is checking for any hardware

		

attached to the computer. The software periodically checks for any

		

changes in connected status of the recorders.
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Over view
This Chapter describes the programming procedures for all of the Recorders.

4.1 Programming the Recorders
This section will define how the recorders can be programmed using DAS™ Data Acquisition Suite.

4.2 Programming the HandiTrap II™ VOD Recorder
The HandiTrap II™ VOD Recorder cannot be programmed. It does not have any user-programmable settings. Please refer to the
HandiTrap II™ VOD Recorder Operations Manual for clarification.

4.3 Programming the MicroTrap™ VOD/Data Recorder
The MicroTrap™ VOD/Data Recorder has the ability to record the velocity of detonation (VOD) as the standard feature with an upgrade
to measure scope data. In order to program the MicroTrap™ VOD/Data Recorder, ensure that the cable drivers have been installed
(normally done when DAS™ is being installed), the USB interface cable has been connected to the computer (displaying a green light at
its end). The cable is then connected to the MicroTrap™ VOD/Data Recorder after 10 seconds, the unit is powered on. If unsure how to
complete this task, refer to the MicroTrap™ VOD/Data Recorder Operations Manual.

4.3.1 VOD Setup in the MicroTrap™ VOD/Data Recorder
With the MicroTrap™ VOD/Data Recorder connected to the
computer, start the DAS™ Data Acquisition Suite. Upon fully
starting, the screen will appear as shown to the right.
Click on the Hardware tab on the left panel of the screen (As
marked in the right image) and the image on the next page will be
displayed.
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Click on the MicroTrap™ VOD/Data Recorder radio button under
Choose Device and the Setup radio button under Hardware. Then
click on the Next button.

This screen will display many details of the individual unit. This
includes the serial number, calibration due date, if a Memory
Upgrade or Scope Upgrade has been installed. This screen will also
display the total number of tests that the memory has been divided
into and the number of tests remaining.
Also, the area highlighted by the box, is the Erase Tests check box.
When checked, it will allow all saved tests to be deleted in the
MicroTrap™ VOD/Data Recorder when the settings are saved.

CAUTION
IF THERE IS IMPORTANT DATA IN THE UNIT, DO NOT CHECK THIS BOX.
If the box is checked, the total number of tests allowed can be changed on next screen.
With the box checked, the software will tell the user how many tests will be erased.
With the standard MicroTrap™ VOD/Data Recorder, only the VOD radio button can be selected. If existing tests needs to be cleared
or number of total tests needs to be changed, check mark “Allow tests to be erased” (Tests can also be erased directly on the recorder,
please refer to the MicroTrap™ VOD/Data Recorder Operations Manual.)
Once the choices have been made on this screen, click on the Next button.
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On this screen, the user will be able to adjust all of the VOD settings
on the MicroTrap™ VOD/Data Recorder. This includes the VOD
Trigger Level, Pre-Trigger Time, Number of Tests (if the Erase Tests
check box on previous screen is checked)), the Sampling Rate and
the settings for the external trigger. Refer to the MicroTrap™ VOD/
Data Recorder Operations Manual for definitions on these settings.
Once the settings have been selected, click on Change Settings
button.

The DAS™ Data Acquisition Suite will
confirm that the user wishes to changes
the settings. If the user is sure, click
Yes, if not click No. Once Yes has been
selected, the software will confirm that the settings have been saved and that the USB cable will need to be disconnected from the unit,
wait 10 seconds then reconnect so that new settings can take effect. Generally, this is also done with a power off, wait 10 seconds
and then power on MicroTrap™ VOD/Data Recorder. Then select the Finish button and the software will return to the main screen of the
software.

4.3.2 Scope Setup in the MicroTrap™ VOD/
Data Recorder
With the MicroTrap™ VOD/Data Recorder connected to the
computer, start the DAS™ Data Acquisition Suite. Upon fully
starting, the screen will appear as shown to the right.
Click on the Hardware tab on the left panel of the screen as
highlighted in the image and the image on the next page will be
displayed.
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Click on the MicroTrap™ VOD/Data Recorder radio button under
Choose Device and the Setup radio button under Hardware. Then
click on the Next button.

This screen will display many details of the individual unit. This
includes the serial number, calibration due date, if a Memory
Upgrade or Scope Upgrade has been installed. This screen will also
display the total number of tests that the memory has been divided
into and the number of tests remaining.

CAUTION
IF THERE IS IMPORTANT DATA IN THE UNIT, DO NOT CHECK THIS BOX.
If the box is checked, the total number of tests allowed can be changed on next screen.
With the box checked, the software will tell the user how many tests will be erased.

With the Scope Upgrade in the MicroTrap™ VOD/Data Recorder, the user can select any of the 3 different radio buttons. In this section,
the Scope radio button will be selected. Once the items have been selected on this screen, click on the Next button.
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This screen will allow the user to adjust all of the Scope settings
including the Scope Trigger Level, Pre Trigger Time, Number of
Tests, Sampling Rate, Enabled Scope Channels with the voltage
range and if that channel will be a Trigger. This screen will also
allow the user to configure the External Trigger. Refer to the
MicroTrap™ VOD/Data Recorder Operations Manual for definitions
of the settings. Once all of the settings have been selected, the user
will need to click on Change Settings.

The DAS™ Data Acquisition Suite will
confirm that the user wishes to changes
the settings. If the user is sure, click
Yes, if not click No. Once Yes has been
selected, the software will confirm that
the USB cable will need to be disconnected from the unit, wait 10 seconds then reconnect so that new settings can take effect. Generally,
this is also done with a power off, wait 10 seconds and then power on the MicroTrap™ VOD/Data Recorder. Then select the Finish button
and the software will return to the main screen of the software.

4.3.3 VOD & Scope Setup in the MicroTrap™ VOD/Data Recorder
With the MicroTrap™ VOD/Data Recorder connected to the
computer, start the DAS™ Data Acquisition Suite. Upon fully
starting, the screen will appear as shown to the right.
Click on the Hardware tab on the left panel of the screen as
highlighted in the image and the image on the next page will be
displayed.
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Click on the MicroTrap™ VOD/Data Recorder radio button under
Choose Device and the Setup radio button under Hardware. Then
click on the Next button.

This screen will display many details of the individual unit. This
includes the serial number, calibration due date, if a Memory
Upgrade or Scope Upgrade has been installed. This screen will also
display the total number of tests that the memory has been divided
into and the number of tests remaining.

CAUTION
IF THERE IS IMPORTANT DATA IN THE UNIT, DO NOT CHECK THIS BOX.
If the box is checked, the total number of tests allowed can be changed on next screen.
With the box checked, the software will tell the user how many tests will be erased.
With the Scope Upgrade in the MicroTrap™ VOD/Data Recorder, the user can select any of the 3 different radio buttons. In this section,
the VOD & Scope radio button will be selected. Once the items have been selected on this screen, click on the Next button.
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This screen will allow the user to adjust all of the Scope settings
including the VOD Trigger Level, Pre Trigger Time, Number of Tests,
Sampling Rate and Enabled Scope Channels with the voltage range.
Note:

With the MicroTrap™ VOD/Data Recorder having VOD

		

enabled, the unit can only trigger internally from the VOD

		Channel. The External Trigger can still be used.
This screen will also allow the user to configure the External Trigger.
Refer to the MicroTrap™ VOD/Data Recorder Operations Manual
for definitions of the settings. Once all of the settings have been
selected, the user will need to click on Change Settings.

The DAS™ Data Acquisition Suite will
confirm that the user wishes to changes
the settings. If the user is sure, click
Yes, if not click No. Once Yes has been
selected, the software will confirm that
the settings have been saved and that
the USB cable will need to be disconnected from the unit, wait 10 seconds then reconnect so that new settings can take effect. Generally,
this is also done with a power off, wait 10 seconds and then power on the MicroTrap™ VOD/Data Recorder. Then select the Finish button
and the software will return to the main screen of the software.

4.4 Programming the DataTrap II™ Data/VOD Recorder
The DataTrap II™ Data/VOD Recorder has the ability to function as ±10 Volt DC Scope as the standard feature with an upgrade to
measure Velocity of Detonation (VOD) data. In order to program the DataTrap II™ Data/VOD Recorder, ensure that the driver has been
installed, the cable has been connected to the computer, connected
to the DataTrap II™ Data/VOD Recorder with the unit powered on.
If unsure how to complete this task, refer to the DataTrap II™
Data/VOD Recorder Operations Manual.

4.4.1 Scope and VOD Programming in the 		
		 DataTrap II™ Data/VOD Recorder
With the DataTrap II™ Data/VOD Recorder connected to the
computer, start the DAS™ Data Acquisition Suite. Upon fully
starting, the screen will appear as shown to the right.
Click on the Hardware tab on the left panel of the screen and the
following will be displayed.
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Select DataTrap II™ Data/VOD Recorder from the Choose Device
and Setup from the Hardware window and the following window is
displayed.

In the Setup Mode window, there are four (4) options. The options
are: Clear All Tests, Standard Setup, Advanced Setup and Recall
Setup File.

4.4.1.1 Clear All Tests
When the user selects Clear All Tests radio button on the Hardware
tab and clicks Next, the following window will appear.
This operation will delete all of the tests currently saved in the
DataTrap II™ Data/VOD Recorder and will keep the settings.
Note that if there are no more tests available to be conducted in
DataTrap II™, the Clear All Tests option must be used first before
user is allowed to use Standard or Advanced setup screens.
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The user will need to confirm the action of clearing all the test data in the unit by clicking
Clear All Tests button. If the user does not want to proceed, the Cancel button can be
clicked.

When OK has been selected, the user will receive conformation that the data has been deleted. The user will
then need to click the Cancel button on the Clear All Tests screen to return back to the main menu.

4.4.1.2 Standard Setup
This section describes the details of the Standard Setup for the
DataTrap II™ Data/VOD Recorder. This will be the recommended
programming option for majority of the users.

When the user selects Standard Setup radio button on the
Hardware tab and clicks Next, the following window will appear.

If the unit’s last setup was Advanced Setup and now the Standard
Setup is chosen, the
following message
will appear.

If the user wishes to continue in the Standard Setup click Yes, if not, click No or Cancel.
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This is the standard setup screen for the DataTrap II™ Data/VOD Recorder. This screen will tell a lot of information about the DataTrap
II™ Data/VOD Recorder, working top to bottom, in the first section the Serial Number, the date the Calibration is due, the number of tests
used, the total tests the memory has been divided into, if the VOD Upgrade has been installed and the amount of memory installed. This
menu will allow the user to control the setup of each individual channel with its own settings.
In the next section down labeled Change Number of Tests, if the radio button Keep Stored Tests is selected, the box to the right of
Total Number of Tests will display the number of tests the memory has been divided into, if Clear Stored Tests is selected, a slide bar is
displayed to the right of Total Number of Tests for the user to change the number of total tests the memory is divided into.
The third section is the details of each channel. With the DataTrap II™ Data/VOD Recorder, there are 8 channels for the user to configure.
The check box beside each number will enable (when checked) or disable (when not checked) each channel. The user can independently
change the voltage range setting of each channel to suit the voltage range of input signal. This is the standard setup for a scope channel
on the recorder.
Note:

If the VOD Upgrade is installed in the unit, VOD will be able to be selected in the Input Range. The standard Trigger settings for 		

		the internal Trigger or a VOD Channel is Low Level with the Trigger Level set to 90%.
The next line in the third section displays the status of the External Trigger. The External Trigger can be modified in the lower left corner
of the screen and will be described later in the manual. The next line displays the status of the Internal Trigger which can be modified in
the lower right corner of the screen and will be described later in the manual. The sample speed of each channel can be independently
changed to suit the input signal or the recording time required. In the bottom part of the third section is the display of total time for each
channel followed by the Pre-Trigger time. The Pre-Trigger time can be adjusted by the slider below and to the left labeled Pre-Trigger
Time. It is adjusted in percentage of the total time available for the channel.
To the right of the Pre-Trigger Time slider is the check box for Internal Trigger to set the internal trigger for VOD. Since this unit does not
have the VOD option installed, this check box is not available and has been greyed out. If the VOD Upgrade was installed, the check
box would be available but this check box would only effect tthe channels which have their Input Range set to VOD. Below the check box
is the settings for the internal trigger. There are six (6) choices: Low Level, High Level, Rising Edge, Falling Edge, Rising or Falling Edge
and Off with a sider bar to adjust the level for the trigger. To the left of the Internal Trigger settings is the External Trigger settings. There
are six (6) choices: TTL Low, TTL High, Make, Break, Make or Break and Off. For details of each of the twelve (12) settings, refer to the
DataTrap II™ Data/VOD Recorder Operations Manual.
The bottom left of the screen is a button that will change all of the
settings of Channels 2 through 8 to how Channel 1 has been setup.
This is a quick option for the user to configure Channel 1 and click
this button to automatically setup all the other channels.
At any time the user wishes to exit the Standard Setup of the
DataTrap II™ Data/VOD Recorder without saving new settings, the
user can select the Close button in the lower right.
If the operator uses multiple setups with the unit, the user can save
the individual setups in a setup file to be recalled at a later date. To
save the file, the user will need to configure the unit as described
above and once complete, the user will click on the Save to File
button. This will open a directory/file structure window from the
local computer as shown to the right.
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The software will default to a standard location on the local hard drive, but the user can place the files in any location that is desired. A
file name that describes the setup is required by the user to be typed into the File Name window. The user then would click Save. The file
extension for this file is .dt2s. The description on recalling this file will be described later.
Once the user has configured the DataTrap II™ Data/VOD Recorder with the desired
settings, Apply Settings must be clicked to upload the settings into the unit. Once the
button has been clicked, the following box will appear.

The user will need to click OK if the settings are desired to be uploaded to the unit or
Cancel if a mistake has been made. Once OK has been selected, the file will upload new settings to
the unit and the following message will be displayed.
Once OK has been selected, the software will return to the main screen.

4.4.1.3 Advanced Setup
This section describes the Advanced Setup of the DataTrap II™
Data/VOD Recorder.

I M P O R TA N T
This section should only be used by either
experienced DataTrap II™ Data/VOD Recorder users
or veteran data collectors.

With the Advanced Setup radio button selected on the Hardware
tab and the Next button clicked, the following screen will appear.
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The Advanced Setup of the DataTrap II™ Data/VOD Recorder is
quite powerful and if the user is not careful, some channels may not
get recorded due to an invalid trigger setting. This screen will tell
a lot of information about the DataTrap II™ Data/VOD Recorder,
working top to bottom, in the first section the Serial Number, the
date the Calibration is due, the number of tests used, the total tests
the memory has been divided into, if the VOD Upgrade has been
installed and the amount of memory installed. This menu will allow
the user to control the setup of each individual channel with its very
own settings.
In the next section down labeled Change Number of Tests, if the
radio button Keep Stored Tests is selected, the box to the right of
Total Number of Tests will display the number of tests the memory
has been divided into. If Clear Stored Tests is selected, a slide bar
is displayed to the right of Total Number of Tests for the user to
change the total number of tests the total memory is divided into.
The next section describes the Network Setup Groups (or trigger
grouping). This is a quick overview of the trigger setup for all of the
triggers. In the above example, all of the channels are in Group A.
This means that if any of those channels cross the trigger threshold
(to be described later) then all of those channels will trigger and
call that point in time the zero point. In the Advanced Setup, the
user can select groupings of channels to be triggered. By placing
different channels in different groups, one grouped channels will trigger when any
channel in that group triggers. This gives channels in different grouping the ability to
trigger at a different time and possibly record for longer time if recording at slower
sampling rate. This kind of setup calls for careful planning of channel grouping so as
to ensure reliable capture of valuable data. If the user clicks on the Edit button at the
end of the Group row, the following window will be displayed.
In Network Setup Groups window, the user can select the groupings of the channels
that are to be triggered together. The user has the ability to have each and every
channel trigger separately. Once the user has selected the required groupings of the channels, click OK. If a change is not required, click
Cancel.
To the right of the trigger group selection is the External Trigger. There are six (6) choices: TTL
Low, TTL High, Make, Break, Make or Break and Off. For details of each of the six (6) settings,
refer to the DataTrap II™ Data/VOD Recorder Operations Manual.
Below the trigger group selection is tabs labelled 1-8. These are the individual details and the
configuration settings for each channel, beside the number at top there is a check box. If this
check box is not checked, the channel will be disabled. Within this section, the user can select
the sampling rate, voltage range, including VOD if the VOD Upgrade has been installed, can
review and change the triggering group (by clicking on Edit), review the total amount of time
and change and review the pre-trigger time with the slide bar. This is the setup for a standard
scope channel on the unit. If the VOD Upgrade is installed in the unit, the standard Trigger Level
for the internal Trigger are Low Level with a Trigger Level set at 90%. In this section, the user
can click on Edit Memory Allocation. It will display the Time Balancing window.
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The user has the ability to change the number of points allocated to each channel. The user can click on the up and down arrows beside
the number of samples (points) to change the memory available to each channel. The user will need to monitor the value in the Unused
Samples as this can never be less than zero. Therefore, the number of points will need to be reduced in one of the channels prior to
increasing them in another. With the changing of the number of points, the amount of time in each channel will change. This screen will
display the amount of time with the selected sampling rate for the user to review prior to continuing. When the user is satisfied with the
memory allocation, they will need to click OK or if the changes are not desired, click Cancel.
The next section refers to the External Trigger. If in the upper section the External Trigger is set to OFF, then in this section the only choice
is OFF for all channels and the ON is labelled in red for each channel. If a selection in the upper section other than OFF is selected, than
ON is in black and the radio button has the
ability of being selected for the channel.
When the ON radio button is selected, the
type of trigger that was selected above is
displayed to the right of the button. To the right of the External Trigger OFF/ON area is a label displaying the current channel and any
channels that can trigger the current channel. This is confirmation display of the trigger grouping window settings and to ensure the user
is aware of the channels that are effected by the decisions above.
The bottom part of the screen is the Internal Trigger setup.

I M P O R TA N T
This is the setup for each individual channel.
Each channel has independent trigger levels. The small graphic
of simulated data trace is to demonstrate when a valid trigger is
received. Each channel can have two (2) Internal Trigger levels
as shown. Trigger 1 is the red line while Trigger 2 is the green
line. In the top image Trigger 1 is set to High Level at 4.5 Volts
and Trigger 2 is set to Low Level at -4.5 Volts. In the graphic
on the right side, the circles will indicate when a valid trigger
is received. When the circle is lit, the DataTrap II™ Data/VOD
Recorder would register a valid trigger for that channel. In the top
example the data tracer is between -4.5 and 4.5 Volts so both
indicators are off. In the bottom example, Trigger 1 is set to Low
Level at 4.5 Volts and Trigger 2 is set to High Level at -4.5 Volts, so
with the data tracer in the middle, it is registering a valid trigger.
For more details on the effect of the individual triggering modes,
refer to the DataTrap II™ Data/VOD Recorder Operations Manual.
At any time the user wishes to exit the Advanced Setup of the
DataTrap II™ Data/VOD Recorder with out saving, the user can
select the Close button in the lower right. If the operator uses
multiple setups with the unit, the user can save the individual setups
in a setup file to be recalled at a later date. To save the file, the
user will need to configure the unit as described above and once
complete, the user will click on the Save to File button. This will
open a directory/file structure window from the local computer as
shown to the right.
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The software will default to a standard location on the local hard drive, but the user can place the files in any location that is desired. A
file name that describes the setup is required by the user to be typed into the File Name window. The user then would click Save. The file
extension for this file is .dt2s. The description on recalling this file will be described later.
Once the user has configured the DataTrap II™ Data/VOD Recorder with the desired
settings, Apply Settings must be clicked to upload the settings into the unit. Once the
button has been clicked, the following box will appear.

The user will need to click OK if the settings are desired to be uploaded to the unit or Cancel if
a mistake has been made. Once OK has been selected, the file will upload to the unit and the
following message will be displayed.
Once OK has been selected, the software will return to the main screen.

4.4.1.4 Recall Setup File
This section describes how the user can recall a saved setup file
generated from the previous section.

When the user selects Recall Setup File and clicks Next, the
following window will appear.
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The user MUST check the check box to agree to erase all of the current data saved in the DataTrap II™ Data/VOD Recorder, otherwise the
Next button will not be able to be selected. Only the Cancel button is available to be selected without the check box checked. With the
box checked, the user can click on the Next button.
The next screen displays the same file structure window displayed
when the file was saved. The user MUST select a file or only the
Back and Cancel buttons are available. When the file has been
selected, the Finish button will become selectable.

This window to the right will be displayed as the file is being checked against the
configuration of the DataTrap II™ Data/VOD Recorder.

If the file is configured for a VOD setting and the unit does not have a VOD Upgrade
installed, the following window will be displayed.

If the Setup File is configured properly for the DataTrap II™ Data/VOD Recorder, the screen of either Standard or Advanced Setup will be
displayed. This will depend on which type of setup was used to create the file being recalled. The user would then need to click Apply
Settings to save the configuration to the unit.
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Chapter 5
Downloading from the
Recorders
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Over view
This section describes how the data is retrieved from the recorders. Here the procedure is
described for each type of recorder.

5.1 Downloading from the HandiTrap II™ VOD Recorder
This section will detail the download procedure for the
HandiTrap II™ VOD Recorder. With the unit connected to the
computer and the hardware tab selected, the following screen will
be displayed.
With the radio buttons selected of HandiTrap II™ VOD Recorder
in the Choose Device section, Download selected in the Hardware
section and Download All Tests in the Test Selection, the user will
click on Next. The following screen is displayed.

This window shows the directory/file structure of the computer. The
user will need to select a directory on the hard drive where the
data is to be saved. With the location selected, an appropriate file
name that is meaningful to the data will need to be typed into File
name. The default file name provided can be used as well. In the
box below is a comments box where some details are captured
including the type of recorder and date with time of download. The
user can add additional notes regarding the test including but not
limited to: location, hole size, hole depth, explosive type, explosive
column length and designed booster location. The selection of the
VOD units should be selected next in order to display the Probe
values in the selected units. The user will need to select the correct
probe that was used during the test, by choosing a valid option
from the pull-down menu. The user should type in the Serial Number
of the unit in the box to the right of the VOD Units. The user can
click Download to start the process or Cancel to exit. When Download process has
been started, the following progress bar will be displayed.
Once complete, the following box will be displayed informing the user that the
retrieval has been completed. The user must click OK.
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This will return to the download screen and the user can click Close to exit the download area for the HandiTrap II™ VOD Recorder.
Each of the downloaded files from the HandiTrap II™ VOD Recorder generates two files with the same user file name entered while
downloading. The .ht2 file is the configuration file while the .raw is the data file. If the test files are moved from one directory to another,
both files are required to be moved.
If the user has download a test with incorrect probe value, download the test again with correct choice of probe value. (Do not turn off the
recorder otherwise test will be lost).

5.2 Downloading from the MicroTrap™ VOD/Data Recorder
This section will detail the download procedure for the MicroTrap™
VOD/Data Recorder. With the unit connected to the computer and
the hardware tab selected, the follow screen will be displayed.
With the radio buttons selected of MicroTrap™ VOD/Data Recorder
in the Choose Device section and Download selected in the
Hardware section. There are two types of downloads that can occur
with the MicroTrap™ VOD/Data Recorder. When there are more
than one test stored in the memory of the unit, both radio buttons
are available, Download All Tests and Download Selected Tests. This
manual will step through both options.

5.2.1 Download All Tests - MicroTrap™ VOD/
Data Recorder
With the Download All Tests radio button selected, the user will need
to click on Next.
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This is the screen that the user will view showing the directory/file
structure of the computer. The user will need to select a directory
on the hard drive where the data is to be saved. With the directory
selected, an appropriate file name for the group of tests that are to
be downloaded needs to be entered in the File Name text box. The
default file name provided can be used as well.

When the Download button is clicked, the following progress bar is displayed.

When the download has been completed, click OK to display the Accept screen as
shown below.

When the downloading of tests has been finished, the following screen is displayed. The user has to accept
the test by clicking Accept Test button for each test downloaded.
On the top of the screen is the directory/file structure of the local
computer.
On the right side, the user selected name appended by _01 for the
first test and _02 for the second test. Each of the MicroTrap™ VOD/
Data Recorder downloaded tests comprise of two files. A .mcr file
for the configuration of the unit and a .raw is the data file. If these
files are moved from one directory to another, both files are required
to be moved. This example shows the download of both tests.
Just below the file structure window shows the following information
about this test. In the image to the right, this is the comments text
box for Test 1 of 2 downloaded in this session. The user can enter
any important and relevant information regarding the test. For
example: Location, hole size, hole depth, explosive type, gauge type, gauge serial number, signal amplification, gauge location.
In the next section, the user should select the units prior to selecting the Probe to ensure the correct units are displayed in the pull-down
box. To the right of the VOD Units is the display of the Serial Number. Below is the display of the individual channel details. If the VOD
channel is OFF (on units with the Scope Upgrade), the Probe selection pull-down is unavailable. When all of the data has been entered
into Test 1, the user needs to click Accept Test 1. The next test will be displayed and the above process needs to be completed for each
individual test downloaded. The unit can store up to 16 individual tests in the recorder.
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Note:

For VOD channels, the correct Probe MUST be selected. This cannot be changed later.

Once all of the data has been entered for all of the downloaded tests, the following window appears. The
Cancel button if clicked rejects the test and no files for it will be created when download process is finished.

5.2.2 Download Selected Tests - MicroTrap™ VOD/Data Recorder
This section will detail the Download Selected Tests options of the
MicroTrap™ VOD/Data Recorder download feature.

When the user selects the Download Selected Tests and presses the
Next button, the following screen will appear.
This is the screen showing the directory/file structure of the
computer. The user will need to select a directory on the hard
drive where the data is to be saved. With the directory selected,
an appropriate file name for the group of tests that are to be
download needs to be entered in the File Name text box (a default
name is suggested). If all of the tests are checked, the software
will act as if the Download All Tests button was selected and is
described in Section 5.2.1. The user will enter the name (a default
name is suggested) and only check-mark the tests that is desired to
be downloaded.
When the Download button is clicked, the following progress bar is
displayed.

When the download has been completed, click OK to display the Accept screen as
shown below.

T: +1-613-545-0466

www.mrel.com contact@mrel.com

38
On the top of the screen is the directory/file structure of the local
computer.
On the right side, the user selected name followed by _01 for the
first test and _02 for the second test from memory. Each of the
MicroTrap™ VOD/Data Recorder downloaded tests comprise of
two files. A .mcr file for the configuration of the unit and a .raw
is the actual data. If these files are moved from one directory to
another, both files are required to be moved. This example shows
the download of 1 test.
Just below the file structure window shows which test the following
information is for. In the image above, this is the comments text
box for Test 1 of 2. The user can enter any important and relevant
information regarding the test.
In the next section, the user should select the units prior to selecting
the Probe to ensure the correct units are displayed in the pull-down box. To the right of the VOD Units is the display of the Serial Number.
Below is the display of the individual channel details. If the VOD channel is OFF (on units with the Scope Upgrade), the Probe selection
pull-down is unavailable. When all of the data has been entered into Test 1, the user needs to click Accept Test 1. If more than one test
was selected for download, each test will cycle with the same screen.
Note:

For VOD channels, the correct Probe MUST be selected. This cannot be changed later.

If only one test was selected, as in this example, the user will click on Accept Test 1 and the following
window will be displayed. The Cancel button if clicked rejects the test and no files for it will be created
when download process is finished.

5.3 Downloading from the DataTrap II™ Data/VOD Recorder
This section will detail the download procedure of test data for the DataTrap II™ Data/VOD Recorder. With the unit connected to the
computer and the hardware tab selected, the follow screen will be displayed.
With the radio buttons selected of DataTrap II™ Data/VOD
Recorder in the Choose Device section and Download selected in
the Hardware section. There are two types of downloads that can
occur with the DataTrap II™ Data/VOD Recorder. When there are
more than one test stored in the memory of the unit, both radio
buttons are available, Download All Tests and Download Selected
Tests. This manual will step through both options.
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5.3.1 Download All Tests –
		 DataTrap II™ Data/VOD Recorder
With the Download All Tests radio button selected, the user will
need to click on Next.

This is the screen that the user will view showing the directory/file
structure of the computer. The user will need to select a directory
on the hard drive where the data is to be saved. With the directory
selected, an appropriate file name for the group of tests that are to
be download needs to be entered in the File Name text box. The
default file name provided can be used as well.

When the Download button is clicked, the following progress bar is displayed.

When the download has completed, the DAS™ Data Acquisition Suite will confirm the successful finish. The
user will need to click on OK to continue with Accept screen as follows.
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Afterwards the following Accept screen is displayed, which is
essential part of download process.
On the top of the screen displays the file path on the local
computer where the file has been saved.
In the File Comment section, the user can enter any important and
relevant information regarding the test. For example: Location, hole
size, hole depth, explosive type, gauge type, gauge serial number,
signal amplification, gauge location.
To the right is the VOD selection. If VOD is present in data, the
VOD Units will be selectable as well as the pull-down menu will be
available for the user to select the correct probe. This will be the
default setting for all VOD channels. The user should select the units
prior to selecting the Probe to ensure the correct units are displayed
in the pull-down box.
The next button down is the Add New Sensor Device or Formula. Refer to Section 5.4 that describes this function separately.
In the grid view is the configuration of the DataTrap II™ Data/VOD Recorder referencing the channel number and the voltage settings
(or VOD) during the recording. In the Probe Values/Device Sensors, the user would use this menu to pre-select the calibration factors of
sensors that have been entered into the system using the Add New Sensor Device or Formula or VOD Probe. Otherwise, if No Device
Selected is selected the data will be displayed in Volts.
Note:

For VOD channels, the correct Probe MUST be selected. This cannot be changed later.

The Orientation column is designed for the user to input a specific orientation of the particular channel. This is generally used in
accelerometers or strain gauges. This information is about the sensor & gauges used to collect data.
If the DataTrap II™ Data/VOD Recorder has the Strain Upgrade installed and the channel is connected to
a strain gauge then the user must check the box of the particular channel that is a strain channel. This will
allow the user to then select the Pre-Amp Resistance and the Strain Gauge Factor. The user will need to
enter these values to allow the DAS™ Data Acquisition Suite software to convert the recorded data into the
microstrain (μϵ).
The user must then click Accept button to save the current test or Cancel button to reject it. Click OK in the
final download message to finish the process.
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5.3.2 Download Selected Tests – DataTrap II™ Data/VOD Recorder
This section will detail the Download Selected Tests options of the
DataTrap II™ Data/VOD Recorder download feature.

When the user selects the Download Selected Tests and presses the
Next button, the following screen will appear.
This is the screen that the user will view showing the directory/file
structure of the computer. The user will need to select a directory
on the hard drive where the data is to be saved. With the directory
selected, an appropriate file name for the group of tests that are
to be download needs to be entered in the File Name text box.
The default file name provided can be used as well. Below the
name text box, the test numbers available for download are being
displayed. If all of the tests are checked, the software will act
exactly as if the Download All Tests button was selected and is
described in Section 5.2.1. The user will enter the name and only
check-mark the tests that are desired to be downloaded. In this
example, only Test 1 will be selected.
When the Download button is clicked, the following progress bar is displayed.

When the download has completed, the DAS™ Data Acquisition Suite will confirm the successful finish. The
user will need to click on OK to continue with Accept screen as follows.

T: +1-613-545-0466

www.mrel.com contact@mrel.com

42
Afterwards the following Accept screen is displayed, which is
essential part of download process.
In this example, only test 2 was selected for download.
On the top of the screen displays the file path on the local
computer where the file has been saved.
In the File Comment section, the user can enter any important and
relevant information regarding the test.
To the right is the VOD selection. If VOD channel is present in data,
the VOD Units will be selectable as well as the pull-down probe
values menu will will be available for the user to select the correct
probe. This will be the default setting for all VOD channels. The
user should select the VOD Units radio button prior to selecting the
Probe to ensure the correct units are displayed in the pull-down box.
The next button down is the Add New Sensor Device or Formula. Refer to Section 5.4 that describes this function separately.
In the grid view is the configuration of the DataTrap II™ Data/VOD Recorder referencing the channel number and the voltage settings
(or VOD) during the recording. In the Probe Values/Device Sensors, the user would use this menu to pre-select the calibration factors of
sensors that have been entered into the system using the Add New Sensor Device or Formula or VOD Probe. Otherwise, if No Device
Selected is selected the data will be displayed in Volts.
Note:

For VOD channels, the correct Probe MUST be selected. This cannot be changed later.

The Orientation column is designed for the user to input a specific orientation of the particular channel. This is generally used in
accelerometers or strain gauges. If the DataTrap II™ Data/VOD Recorder has the Strain Upgrade installed and the channel is connected
to a strain gauge then the user must check the box of the particular channel that is a strain channel. This will allow the user to then select
the Pre-Amp Resistance and the Strain Gauge Factor. The user will need to enter these values to allow the
DAS™ Data Acquisition Suite software to convert the recorded data into the microstrain (µϵ) units. For
hardware configurations for Strain Channel setup, refer to the DataTrap II™ Data/VOD Recorder Operations
Manual.
The user must then click Accept button to save the current test or Cancel button to reject it. Click OK in the
final download message to finish the process,

5.4 Add New Sensor Device or Formula
This section describes how the user can input commonly used equations for their applications or sensor calibration factors of sensors that
are currently used. It only can be used on Scope data and NOT on VOD data. Therefore, this section is not applicable to the
HandiTrap II™ VOD Recorder or the standard MicroTrap™ VOD/Data Recorder. Adding sensors will assist the user in allowing the ease
of the application of the calibration data for each individual sensors. These sensor equation/calibration can be applied to the data ONLY
during downloading of test data from DataTrap II™ Data/VOD Recorder.
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5.4.1 Entering a New Sensor
A new sensor, device or formula can be added into the software from the main menu under the Hardware
tab.
Click on Add New Sensor Device or Formula and the
following widow will appear.

The names that are typed into the Quantity and Unit text boxes are the units of the Y-axis quantity in the
graph. By default, y-axis label is generated using these units and quantity. Y-axis caption or label can be
changed by user independently (note that does not change quantity or related units). Various examples for
Quantity text box are Distance, Length, Pressure, Acceleration, Temperature, Force, etc. Various examples
for the Units text box are metres, feet, kPa, psi, g’s, m/s^2, Celsius, Fahrenheit, Kelvin, Rankine and so on.
This is displayed in the Y-Axis box at the bottom. There are two options for adding information for quick
reference: Add Linear Sensor and Add Sensor Formula. These formulas or equations can only be applied to
the data while accepting each test during downloading of data from DataTrap II™. There are other facilities
to create formulas and apply them on demand in Analyze ribbon menu (See Apply Formula in Filters and
Formulas tab).

5.4.2 Add Linear Sensor
The user will use Add Linear Sensor when a sensor is used with a calibration value. This will allow a quick selection of the intended sensor
with the proper calibration to be applied to the the collected data when accepting a test from DataTrap II™.
When the Add Linear Sensor button is clicked the following window is displayed.
The definition of the Y-Axis is shown at the top and the user is required to enter a Device
Name. This is the name of the sensor which will appear in a device list on the Accept
screen of DataTrap II™ data download process. In this example, the serial number of
the sensor has been entered. From manufacturer calibration sheet, numerical value of
the sensor calibration is entered in device formula text box and correct units is selected
on the right with radio buttons choice. The Frequency Limits are informational values
entered by the user. This information can be referred to at a later date without looking up
the frequency limits on the technical specifications of the sensor. The user will then select
Save to add the device to the list or Back to return to the previous screen or Cancel to stop
the process.
Once Save has been clicked, the following message is displayed. The user should click
OK to return to previous screen. The user can add another sensor or formula on the main screen or click
Cancel to close it.
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5.4.3 Add Sensor Formula
The user will select this button when straight math formula is needed to be applied to
the collected data. When Add Sensor Formula button is clicked, the following window is
displayed.
The user can enter any valid mathematical equation into the Y= text box. To the right is
a window describing all of the different mathematical expressions that can be used to
modify the voltage that has been recorded.
With the formula entered into the text box, the user can click Check Formula and confirm
that the format of the equation is correct if a check mark appears in the check box labeled
Formula Validated.
At any time, the user can select Back to return to the previous screen and Cancel to exit.

When the user clicks Save, the following message is displayed. Click OK to return to previous screen
where the user can continue adding other sensors or Cancel to close it.
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Chapter 6
Opening a Data File
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Over view
This section describes how to open a previously saved data file downloaded from either a
HandiTrap II™ VOD Recorder, MicroTrap™ VOD/Data Recorder or DataTrap II™ Data/VOD
Recorder.

6.1 Selecting a Data File
From the main screen, select the Open Data File tab. The following
screen will be displayed.
By default, all recorder data file types are selected (DT2-DataTrap
II™ Data/VOD Recorder, HT2-HandiTrap II™ VOD Recorder, MTMicroTrap™ VOD/Data Recorder). The user can select only the
one type of file if desired. Once the desired file type is selected
to be visible in the next screen, there are four (4) different ways to
search for a file. They are Browse, Recently Opened Files, Recently
Downloaded and Calendar.

6.2 Browse
The Browse feature is the typical way to use the file browser to find
a file. By clicking the Browse radio button and selecting Next, the
following screen will be displayed.
This screen will allow the user to navigate through the directory/file
structure of the computer to find the desired file. From the previous
page, only the selected file types will be displayed. The user can
click on Go To Home to return to the default directory defined in
the software. When the desired file is located, select the file by left
clicking on the file name once and then clicking Open. To stop the
process, click Cancel. When Open has been clicked, the file will
start to load. After file is loaded, the main window will return with
the Analyze tab opened. To analyze the data, refer to the
Analyze section.
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6.3 Recently Opened Files
This section is used to open a file that has been opened recently.
The computer will record the files that have been opened and will
produce a list of files for the user.

The user will select Recently Opened Files radio button from the
Open Data File tab and select Next and the following window will
appear.
The DAS™ Data Acquisition Suite will display eight (8) previously
opened files. This includes all of the file types selected in the File
Type window in the previous section. The user will just click on
the blue link and the file will open and the file will show up in the
Analyze tab. If no files wish to be opened from the list, the user can
click Close.
If there is a zip button present next to a file entry,
clicking it will create a zip file of original data on your
desktop. That is useful if you want to send data to MREL
(see Section 10.2)

6.4 Recently Downloaded Files
This option will open a list of the most recent downloaded files from
the recorders.
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With the Recently Downloaded radio button selected and selecting
Next, the following window will be displayed.
The DAS™ Data Acquisition Suite will display eight (8) previously
downloaded files. This includes all of the file types selected in the
File Type window in the previous section. The user will just click on
the blue link and the file will open and the file will show up in the
Analyze tab. If no files wish to be opened from the list, the user can
click Close.
If there is a zip button present next to a file entry, clicking
it will create a zip file of original data on your desktop.
That is useful if you want to send data to MREL
(see Section 10.2)

6.5 Calendar
This section is used to open a file if the download date is known.

With the Calendar radio button selected and selecting Next, the
following window will be displayed.
This option will display a calendar for the user to select the date
that the file was downloaded. A blue box is placed around the
current date and the date that is in bold font has a file associated
with that date. In the example above, February 21, 2014 has a
DataTrap II™ Data/VOD Recorder file associated the date. In the
box below is the file location of the data with the file name. All of
the files downloaded on the selected date will show in the bottom
window. The user will select the file from the bottom box and click
Open. The file will open in the Analyze tab. If no files are to be
opened, click Cancel.
If there is a zip button present next to a file entry, clicking
it will create a zip file of original data on your desktop.
That is useful if you want to send data to MREL
(see Section 10.2)
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6.6 Open CSV file
A 2-column CSV (comma separated values) file can be imported in DAS™. The
imported data creates a scope channel. The user has to enter correct time units
for 1st column when asked by importation process. The user has to enter “s” for
seconds, “ms” for milliseconds etc. See the following text box for an example.

6.7 Working With the Data File
The image to the right shows a data file Borehole_Ex.ht2 open. It shows one VOD channel with the
Original Graph, which is indicated by a locked icon, and a saved graph (VOD Graph -0.64 ms) which
is indicated by an unlocked icon. The meaning of the lock is that the data cannot be modified on
permanent basis or saved though it allows you to work with it. A user should always create a saved graph
to work on. A saved graph needs to be created for VOD/Delta calculation, apply filters, formulas, apply
offset (zero shift), moving data points, creating point cursors and annotations and more. To create savable
graphs, the user can Right-Click on the locked graph and save it as a different graph (a default name is
suggested). The saved graph can also be deleted in this manner.
An Active Plot is normally required to do most operations such as exporting data, change plot line or point
colour, creating point cursors, creating annotations, creating VOD or Delta calculations. For making a plot
active, check mark a plot entry in Active Plot Selector Grid on the lower left of Analysis tab. Only one plot
in a graph can be active at a given time.
In the next example shown to the right, the file name of DT2010Oct004_02.dt2 shows 8 channels and
the display All Graphs. The user can also select the All Graphs which provides a display of all original
data from all active channels overlaid on the same screen for visual comparison. There are not savable
operations on this graph but new graph can be saved from this. In this scenario, only current active plot is
saved as new graph. Instead working on individual channels is strongly encouraged. Also in this example,
channel 1 is a VOD channel, channel 2 is a Strain channel and channels 3 through 8 are scope. This
example has no saved graphs on any of the channels. When the user clicks on the channel number, the software will display a summary
of the settings and information for the selected channel on the right side of the screen when the file was downloaded.

6.8 Closing a Data File
To close a data file, Right-Click on the file name in the Graph Tree and select Close. The software will ask for a confirmation, click Yes to
close the file or No to cancel and return to the file. The user can also use Close All in top File menu which closes all opened files.
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Chapter 7
Data Analysis
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Over view
This section will detail the analysis of the data collected from the HandiTrap II™ VOD
Recorder, the MicroTrap™ VOD/Data Recorder and the DataTrap II™ Data/VOD Recorder.
This section will detail the analysis of the data collected from the recorders. It will show how the software will work and not the correct or
incorrect way to analyze certain types of data. The data filtering portion of the software can be found in Section 8. Below is the view of
the software with a data file open. Across the top of the screen is a ribbon menu with six (6) different tabs.
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7.1 Home Tab

In the Home tab most functions are of general nature that are used in graphing, saving and zooming. It includes the following functions:
•

Zoom In

– Allows the user to zoom in on the graph to an area of interest.

The feature works by clicking on Zoom In and selecting a box around the area of interest by dragging a mouse with left mouse
button pressed in.
•

Zoom Out – Allows the user to zoom out.
Click on Zoom Out as many times it is required or until the full view has been reached.

•

Full – Allows a single button click to zoom out to the maximum range of the graph. Click on once for maximum zoomed out area.

•

Original – Allows a one button click to zoom out to the maximum range of the saved graph.
Click on once for the saved graph to return to its original saved range.

•

Pan – Allows for the scrolling of the graph.
The pan button is a toggle ON or OFF. When it is on, the mouse can be used to click in and drag the graph.

•

Save As – Allows a graph to be saved as a new graph with the current zoomed range.
With the current viewable area as desired range, click on Save As and a text box will pop up to allow a name to be entered
by the user.

•

Delete – Allows the Saved As graphs to be deleted. Will not delete the original graphs.
With a saved graph selected, the user can click this button and a conformation box will appear to confirm the deletion of the graph.

•

Point Cursor – Creates a movable vertical point cursor which shows the X, Y coordinate of current data point on the graph.
Click on the button and follow the on screen directions. The Point Cursor can be moved with the mouse or the left and right arrow
keys.
To select an individual point, the user may need to zoom in closer to select the desired point. The user can have multiple Point
Cursors on the screen.
To remove, Right-Click on the Point Cursor and select Delete. Also with the Right-Click on the Point Cursor and selecting Modify, the
user can adjust all of the individual properties on the Point Cursor.
The Show/Hide Point Cursor will allow the user to copy the individual coordinates pointed by point cursors to the clipboard to be
pasted into a different application.

•

Show/Hide - Will allow the user to copy the individual coordinates pointed by the point cursors in the graph to the clipboard so
as to be pasted into a different application. Click on the button. It can also be found in the Right-Click context menu of the individual
Point Cursor or graph.
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•

Annotation – Will allow user to enter text onto the graph. Follow the instructions on screen.
Click on the button and then click on the screen. Right-Click on the Annotation and select Modify to modify the text, colour or font.
From the Right-Click menu, the user can also delete the Annotation.

•

Arrow – Will allow the user to draw an Arrow with a caption.
The user will draw an arrow with a textual caption attached to the end of the line. The user can change the text in the box by rightclicking and selecting Modify. The shape at the arrow end of the line can be removed by in the same Modify box, scroll down to
ShapeStyle and select none. The arrow tip can not be moved without a ShapeStyle present.

•

Line – Will allow the user to draw a Line.
The user will click on the Line button and follow the on screen instructions. The line can be extended or moved. User can modify its
font or thickness using its Modify context menu.

•

Image – Will allow the user to insert a picture.
The user will click on Image and follow the on screen directions. A directory/file structure window will pop up of the local computer.
The user can navigate the computer and select the image of interest. The user will need to select top-left corner of the image to drag
it to the area of interest and will be able to Right-Click on the corner to select Modify and adjust the displayed size. The Modify
dialog box also allows user to select a different image using “Change…” button.

•

Cut – Will allow the selected annotation to be cut. The selected annotation has a red rectangle around it when user Left-Click it
once.
The user will need to select an item and then select Cut. If no item or a non-valid item is selected, the Cut button will not be available.
The item will be placed on the computer’s clipboard.

•

Copy – Will allow the selected annotation to be copied.
The user will need to select an annotation and then select Copy. If no annotation or a non-valid item is selected, the Copy button will
not be available. The annotation will be placed on the computer’s clipboard.

•

Paste – Will allow the last copied or cut annotation to be pasted.
This button will allow the user to Paste the item in the same graph that has been placed on the computer’s clipboard. Note that
annotation can be pasted to different graph nodes of the same or different data file (in version later than 1.0.0.0). VOD and Delta
values cannot be copied or pasted.

7.2 View Tab
In the View tab are features that effect how the data is displayed.
•

Linear – Displays the X and Y axes with a linear scale.
The user can click on the Linear check box to change the axes to Logarithmic

•

Logarithmic – Displays the X and Y axes with a logarithmic scale.
The user can click on the Logarithmic check box to change the axes to Linear
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•

Axes Range – Displays the following text box for the user to manually enter the
axes range
The user can enter specific ranges into the menu without the requirement to zoom.
Enter the desired values and click Apply or if no changes are desired, click Close.

•

Axes Title – Allows the user to modify the axes titles or graph caption.
The user can modify the titles by entering the desired information in the text box and
clicking Apply. If no changes are desired, click Cancel.
From the main graph window, CTRL Key + Left-Click on the X-axis, Y-axis or graph
caption bar to display individual title change dialog.

•

Plotting Styles – Allows the user to change the way a plot is drawn.
The default is Line connecting the data points with a line. Point will only display the data
points while Point + Line will display both. Only the Active plot is affected.

•

Line Thickness – Allows the user to change the line thickness of the active plot.
The user can either click and drag the slider bar or use the + and – buttons to change the thickness
of the drawn line.

•

Point Colour – Allows the user to change colour of the data points of active plot.
The Point Colour button will change the colour of the data points of active plot while the pull down
arrow will allow the user to select the colour from a pallet of colours.

•

Line Colour – Will allow the user to change the line colour of the active plot.
The Line Colour button will change the line colour of the active plot while the pull down arrow will
allow the user to select the colour from a pallet of colours.
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•

Graph Tree – Allows the user to show and hide the graph
tree view on the left side of the screen. It will allow the graph
area to extend from the right image all the way to left edge of
main window:

To the image to the right:
A single click on the Graph Tree button will change back and
forth between the two screens.

•

Grid Lines Major

– By selecting the check box will display the major grid lines.

It can be turned on and off by the check box.
•

Grid Lines Minor – By selecting the check box will display the minor grid lines.
It can be turned on and off by the check box.
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7.3 VOD Tab
NOTE:

•

This tab is only visible when the selected graph (or channel) is VOD data.

Start/Done – Allows the start of the VOD measurement. The button will change to Done after the process has been started.
Follow the on-screen directions and click and drag the vertical point cursors to the desired location. See the Quick Start Guide for the
use of the button. Clicking Done will finish the VOD measurement process.

•

Cancel – Allows the VOD measurement to be canceled.

•

Linear Regression – Allows the user to use Simple Linear Regression to produce a line of best fit of the points between the two
end points.
The definition of Simple Linear Regression is a fit of a straight line through the set of n points in such a way that makes the sum of
squared residuals of the model (that is, vertical distances between the points of the data set and the fitted line) as small as possible.

•

2-Point

– Allows the user to measure VOD with using only the start and end point.

The VOD is calculated by the following equation: (y2-y1)/(x2-x1), where (x1,y1) is the first point and (x2,y2) is the second point. This
is used when the data is ‘noisy’ and the points in the middle need to be ignored. As long as the line matches the straight edge of the
data, then the value obtained from the calculation is valid.
•

Data Section
In this area, values being calculated are displayed when a VOD measurement has started and being calculated dynamically.
The VOD value will be displayed and will change if the user selects Linear Regression or 2-Point method. The values will change
accordingly as user moves vertical data cursors by mouse or left (right) keys. The user can finish VOD calculation process either by
clicking Done button in the VOD tab or in “Choose points for VOD/Delta calculation” dialog. (See more details in Analysis section or
in built-in help.)

7.3.1 How to measure VOD
See VOD Analysis Section 7.7.
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7.4 2-Point Functions Tab

•

Start/Done – Allows the user to measure the amount of time (delta X) and the amount of Y-axis units (m, V or engineering units)
(delta Y) between the two selected points.
The user will select start and will follow the on-screen instruction.

The screen to the right shows the two vertical point cursors and
the two (X,Y) points.In the ribbon menu in the Data section, the
values of the two points and the difference is also displayed.

When Done is clicked, the calculated values are shown on the
graph as in the second screen.
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•

Cancel – The Cancel button is to stop the 2-Point Function operation.

•

Delta X (x-axis units of graph such as ms, s)

– This check box defines if the delta value for quantity X (usually time) is to be

calculated and displayed. If the box is unchecked, the delta value will disappear in the Data section. Also, if the box is unchecked,
the value will not be calculated or displayed when Done is selected.
•

Delta Y (y-axis units of graph such as m, V or engineering units) – This check box defines if the delta value for quantity Y (such as
distance, voltage etc.) is to be calculated and displayed. If the box is unchecked, the delta value will disappear in the Data section.
Also, if the box is unchecked, the value will not be displayed during the calculation process or after when Done button is clicked.

•

Apply Offset – Allows the user to shift all of the data on the vertical
axis of a single channel. This is not applicable to VOD data. The offset
cannot be applied to the original data. It only can be applied to the
saved graphs. If it is attempted to be performed on an original graph, the
following pop up is displayed.

Click on the button and follow the on-screen directions. On the pop up to
the right, click OK and then select the data point which the user wants to
be a zero value on the Y-Axis. When the desired point has been selected,
the following Units And Formula dialog is displayed.

The actual operation is the subtraction of the selected data point’s Y
component as displayed in the formula bar above. The user will select
Apply to shift the data the desired amount in the Y-Axis or Cancel to stop
the operation.

•

Move Data Pt – Allows the user to move a single point in the vertical
direction. This operation can only be performed on Saved Graphs and not
on original graphs.
This feature will allow the user to move a data point that has an error in
the data capture. The user will select Move Data Pt and the following pop
up is displayed. Select OK to continue. Select the point of interest to move
and then the user will be able to move it in the vertical direction.The user
will click again where to place the point.
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If the user is having trouble finding the individual point, the user can go to the View tab and click on Plotting Styles and select Point
+ Line.

7.5 Filters & Formulas Tab

This section describes the use of Formulas. It is the preferred way of applying sensor equation and math formula to scope data. For
discussion on Filters, which is only available in the Advanced Edition, refer to the Advanced Edition Section.
The image above is the tab status when a VOD data channel has been selected. There is no formula that can be applied to the graph.
In the image below is the tab when a scope data channel has been selected.

When the user selects Apply Formula, the following window will appear.
In the Current Formula text box is the current formula being applied to the
data.
In this example, Y=V. The user will enter the formula equation into this text box
using V as the current value of the y data.
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To the right, available operations for the formula box are displayed.

When the equation has been entered, the user can select the Units and
Quantities tab. The user will assign the Y Units (psi, g’s, etc.) and the
Quantities (Pressure, Acceleration, etc.). These quantities and units can be
selected from the pull down menus (if already in the system) or typed in. The
formula and associated quantity/units can be saved by clicking button Add
Formula & Units To Lists. As stated previously, the formula cannot be applied
to an original graph. The Apply button will be greyed out if current graph is
original graph. The user must check-mark Apply To New Graph check box
and then the Apply button will be enabled. The user can always select Cancel.

7.6 Help Tab

This section describes the Help tab.
•

Help – Opens the built-in Data Acquisition Suite Help on the screen in a separate window.

•

Support – Opens an email using your default email client to send an email to das@mrel.com

•

Updates – This will check for any updated releases for the software (Internet access is required). If there is an updated version
available, user can answer YES to download updated package (a zip file) to a temporary folder such as Download folder. Once
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download process is finished, Exit DAS™ (Do not uninstall it), extract the downloaded package in the same temporary folder and
double-click the extracted executable to run it. Follow the prompt. Local Administrative type user account is required to successfully
install the update package.
•

Register – This will restart DAS™ and display registration dialog. The user fills and submit this to get the software registered.
Once registered, user needs to upgrade to Standard or Advanced Edition to continue to use the software beyond one-time 30 day
evaluation period.

•

About – Opens the window showing the version number of the software
and the contact details for MREL Group of Companies Limited including
website, email, address and phone and fax numbers.

•

Keyboard Shortcuts – Displays the keyboard shortcuts.
To the right is the screen.

7.7 VOD Analysis
Analysis of VOD is the measurement of the velocity of detonation
of explosives. The instruments capable of this measurement is:
HandiTrap II™ VOD Recorder, MicroTrap™ VOD/Data Recorder and
DataTrap II™ Data/VOD Recorder with VOD Upgrade. With the
graph opened, the screen to the right is displayed.
In this example, the file name is Borehole_Ex.ht2 which is a
HandiTrap II™ VOD Recorder file. On the left side of the screen, the
column displays all of the important information regarding the file.
This example shows that there is 1 active VOD channel (shown with
a green circle with a white check mark).
The user will need to decide which type of VOD measurement that is
desired: Linear Regression or 2-Point.
Please refer to the descriptions below to which type of VOD
measurement is desired.
With the desired check box selected and the graph zoomed into the relevant
area, click Start. The following screen will be displayed.
Click OK to continue.
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The user will see two vertical point cursors. The selected data points
are displayed (X,Y) where the point cursors intersect the data.
The user can click and drag the point cursors to the the desired
locations. The VOD Feedback Line shown in green here, is a visual
aid to user so a better close match to actual data can be achieved.
If you do not have this, please update DAS™ to latest version
(See Section 2.8).
Reconfirm that the desired method has been selected and the Data
section will display a quick reference to the two points and the VOD
prior to pressing Done.
Once Done has been pressed and the VOD line is displayed, this is
the only time that the user can compare the VOD line to the data.
If the VOD line does not match the data, it is not a valid VOD
measurement.
As shown in the graph to the right, the selected line is not the
best fit for the data. The user can place as many different VOD
measurements as desired.
The line is shown above the data at the beginning, below in the
middle and above the measurement at the end. The image to the
right is a better measurement.

From the screen to the right, the two VOD lines have been closely
fit to the data where each line fits the data in the section of
measurement. This shows a change in velocity from the bottom of
the hole to the top.

T: +1-613-545-0466

www.mrel.com contact@mrel.com

64

7.8 Exporting Graph
7.8.1 Export Graph Data
Right-Click a graph which displays following context menu.
Choose Export to export active plot original data range to a CSV file. Or choose Export Visible to export active plot data using current
visible range of graph to a 2-column CSV file.

7.8.2 Export Graph Image
Right-Click a graph which displays following context menu.
Choose Save As Image which displays a Save as dialog with directory structure displayed on the computer. The user can save the graph
image as Jpeg, Bitmap, Gif and PNG files.

7.9 User Preferences
The user can change various preference applicable (some available in version beyond
1.0.0.0) to many aspects of the software operation. These includes Auto Save, Default
Language (English (default) or French), Ribbon menu Style, Default font, Active plot
legend ON/OFF, Export Time units type (seconds or default), Apply Offset type and
Visual Feedback line colour for VOD. These preferences are controlled through the
following dialog using menu item File > Preferences. See built-in help for details.
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Chapter 8
Advanced Edition
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Over view
This Chapter provides detailed instructions on the Advanced Edition operations and how to
upgrade to the Advanced Edition.

8.1 Upgrade to Advanced Edition
To Upgrade to the Advanced Edition, the user will need to select Help from the
top menu structure and then Select Register/Upgrade…
The registration dialog will appear empty if software is not registered. It will
appear with filled information if it is registered whether upgraded to Standard
Edition or Not upgraded yet. The first image shows an Advanced Edition
registered software (user information is removed here)

At the bottom of the registration dialog is a link to get a quote (info) for
Advanced version upgrade from MREL. If the user has paid for the Advanced
Edition in full, have already registered the DAS™ software on the PC using
Help > Register menu item. After completing registration process, send request
to upgrade using email to das@mrel.com. The invoice# (or its screen shot)
needs to be mentioned in the email. A screen shot of registration screen is
needed for the computer for which Advanced Edition is going to be licensed.
The user will be provided an Advanced Edition license key along with
instructions to apply it.
The processing time may take up to 1 business day or more depending upon
payment status.

NOTE: Some of the features discussed in this manual are available in DAS™ version later than 1.0.0.0. Please check for any available
updates in DAS™.
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8.2 Using Advanced Edition – Filters
Once the software has been upgraded to the Advanced Edition as described
in the previous section, the features of the Advanced Edition will be accessible.
The Advanced Edition offers extra functionality in-addition to what is offered
in Standard Edition. The Advanced Edition will allow the user to apply filters to
the data downloaded from a HandiTrap II™ VOD Recorder, MicroTrap™ VOD/
Data Recorder, DataTrap II™ Data/VOD Recorder or an imported CSV file data.
Moreover, Auxiliary Plots operations such as Curve Fitting and Integration etc.
are available in Advanced Edition. In the image below we have saved Original
Graph as new graph named Low-Pass. Then in the Filters and Formulas tab, the
Open Filters button is clicked. This data has high frequency noise.
When the user clicks on the Open Filters button, the following screen will appear
which shows that the original and filtered plot are the same as no filter is added
and applied yet.
This window allows the user to select different filters to be applied to the data.
In the top-left half (Time-domain view), the original data is displayed from the
file and the lower-half, the filtered Data is displayed if any filters are added
and applied. The user selects an added filter on the right, changes its design
parameters and preview the filtered data by clicking Preview Filters Applied
button, the filtered data changes in lower half of left window. Finally when
filter output meets the design criteria (parameters), user can click Apply & Close
button to create a filtered plot in the main window. The unfiltered plot does not
change.
See below for an example of Elliptic Low pass filter applied to clean the
unfiltered data.
When user is done previewing the filter, the Apply & Close button can be clicked
to accept the results and the main window has filtered plot (blue colour) added
as shown below (or user can Cancel).
We have made Original plot hidden to show Filtered plot clearly in the screen
shot on the right.

Frequency Domain View:
This view is active when FFT plots checkbox is checked marked. It offers
frequency domain plots as an aid to design filters by creating plots such as
Magnitude-Phase plots showing RMS Magnitude (or Power RMS^2) against
linear frequency in Hertz (Hz). Phase is shown in Degrees. A user can switch to
Logarithmic scales using related checkboxes for X and Y scales. The following
is an example of a composite Sine wave (0.75Sine25 + 0.15Sine100) being
filtered for 25 Hz.
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Clearing FFT plots checkbox switches to Time Domain View and shows the
filtered output as shown below:
The Advanced Edition offer the following filter design types which a user can
select to apply to the data:
•

Bessel

•

Butterworth

•

Chebyshev

•

Elliptic

•

Miscellaneous

•

Median

•

Moving Average

•

Savitzky-Golay

•

WindowedFir

Along the top of the filter dialog window, there are 5 tool bar buttons that
include: Zoom In, Zoom Out, Zoom to Full range, Pan, Filtered Data Graph
Colour and a text box for filtered plot line thickness represented by a number.
On the lower-right, the Plot Settings will adjust the settings for both the top and
bottom graph. The Plot Style defines the plotting method of the graphs. The
choices are: Line, Point or Point + Line. The check box Show Original Range will zoom the graph to the range when filter dialog was
started. If the graph has been zoomed in, out or paned, this is the quickest way to return to the range you started with. If unchecked, it
will return to current zoom level. The next check box Original & Filtered will place both original and filtered plots in lower half on the
same axis to allow the user to view the data to see the differences of the effect of the filtering.

8.2.1 Bessel
Bessel filter family is a type of IIR (Infinite Impulse Response) digital filters which provides a maximally flat group delay with linear phase
response. Bessel filters offer very low level of ripples or ringing in the pass band.
The four filter types of Bessel filter design family are: Lowpass, Highpass, Bandpass and Bandstop
Generally Lowpass filter passes through signals having lower frequency than cutoff frequency. Highpass filter passes through signals
having higher frequency than cutoff frequency. Bandpass filter passes through signals which have frequencies within the frequency
range defined by lower cutoff and higher cutoff frequencies. Bandstop filter passes through signals which are not within frequency range
defined by lower cutoff and higher cutoff frequencies.
With the type of Bessel filter added and selected, the user will specify the following parameters for Lowpass and Highpass filters.
•

Filter Order

•

Cutoff Frequency (Hz)

The parameters for Bandpass and Bandstop are as follows:
•

Filter Order

•

Lower Cutoff (Hz)

•

Upper Cutoff (Hz)
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With these parameters provided by the user, the user needs to click Preview Filters Applied to update the Filtered graph and if the desired
filtering effect has been achieved, the Apply & Close button can be clicked. That will create a filtered plot in the Main window of software
in-addition to original unfiltered plot.
Zero Phase Delay checkbox is an optional parameter. If this option is check-marked, filter tries to reduce possible phase delay in output
response. The user should reduce Filter Order to half of its value compared to when this options is NOT on.
The user can apply different filters and arrange their order of application by using Up and Down buttons in Filter dialog. The filters
are applied from top to bottom as per the Current Added Filters list. The Cancel button will close the Filter dialog without applying any
changes and main software window is displayed.

8.2.2 Butterworth
The Butterworth filter design family is a type of IIR (Infinite Impulse Response) digital filters which provides as flat a frequency response
as possible in the passband. It is also referred to as a maximally flat magnitude filter.
The frequency response of the Butterworth filter has a steeper rolls off than Bessel filters. Butterworth filters have moderate ripple and
provide good overall performance.
The four types of filters for the Butterworth filter design family are: Lowpass, Highpass, Bandpass and Bandstop.
With the type of Butterworth filter added and selected in the list, the user will provide the following parameters for Lowpass and
Highpass.
•

Filter Order

•

Cutoff Frequency (Hz)

The parameters for Bandpass and Bandstop are as follows:
•

Filter Order

•

Lower Cutoff (Hz)

•

Upper Cutoff (Hz)

With these parameters provided by the user, the user needs to click Preview Filters Applied to update the bottom graph and if the desired
filtering effect has been achieved, the Apply & Close button can be clicked. That will create a filtered plot in the Main window of software
in-addition to original unfiltered plot.
Zero Phase Delay checkbox is an optional parameter. If this option is check-marked, filter tries to reduce possible phase delay in output
response. The user should reduce Filter Order to half of its value compared to when this options is NOT on.

8.2.3 Chebyshev
Chebyshev filter family is a type of IIR (Infinite Impulse Response) digital filters, having a steeper roll-off and more passband ripple than
Butterworth filters. Steeper roll off can be achieved using Chebyshev filters if more ripples are allowed in pass band. These filters have
better attenuation in the stop band than Butterworth filters.
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With the type of Chebyshev filter added and selected, the user will have the following parameters for Lowpass and Highpass.
•

Filter Order

•

Cutoff Frequency (Hz)

•

Stopband Ripple (dB)

The parameters for Bandpass and Bandstop are as follows:
•

Filter Order

•

Lower Cutoff (Hz)

•

Upper Cutoff (Hz)

•

Stopband Ripple (dB)

With these parameters provided by the user, the user needs to click Preview Filters Applied to update the bottom graph and if the desired
filtering effect has been achieved, the Apply & Close button can be clicked. That will create a filtered plot in the Main window of software
in-addition to original unfiltered plot.
Zero Phase Delay checkbox is an optional parameter. If this option is check-marked, filter tries to reduce possible phase delay in output
response. The user should reduce Filter Order to half of its value compared to when this options is NOT on.

8.2.4 Elliptic
The Elliptic or (Cauer) filter family is a type of IIR (Infinite Impulse Response) digital filter. It provides sharpest roll-off and narrow transition
band for a given filter order. This filter provides good control for amount of stop band ripples along with excellent attenuation for stop
band and has non-linear phase response. The choices of stop band ripple and stop band attenuation controls the transition rate.
With the type of Elliptic filter added and selected, the user will have the following parameters for Lowpass and Highpass.
•

Filter Order

•

Cutoff Frequency (Hz)

•

Stopband Ripple (dB)

•

Stopband Attenuation (dB)

The parameters for Bandpass and Bandstop are as follows:
•

Filter Order

•

Lower Cutoff (Hz)

•

Upper Cutoff (Hz)

•

Stopband Ripple (dB)

•

Stopband Attenuation (dB)

With these parameters provided by the user, the user needs to click Preview Filters Applied to update the bottom graph and if the
desired filtering effect has been achieved, the Apply & Close button can be clicked. That will create a filtered plot in the Main window of
software in-addition to original unfiltered plot.
Zero Phase Delay checkbox is an optional parameter. If this option is check-marked, filter tries to reduce possible phase delay in output
response. The user should reduce Filter Order to half of its value compared to when this options is NOT on.
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8.2.5 Miscellaneous Filters
Formula
The Formula filter applies a math formula to create a filtered plot. The original
plot is not modified. The quantity/units remain the same. Quick examples of
formula filter is inversion (-1.0*V), Signal Offsetting (V + 2.58) or other possible
formula equations. This is in contrast to Apply Formula functionality in the main
screen where formula is applied to unfiltered plot along with any quantity/units
changes. Both Formula filter and Apply Formula are applicable to Scope type of
graphs only.
Negative Distance Removal
This filter is applicable to VOD type of graph only. It has two parameters which specifies the starting and end x-axis range values. The
negative distance spikes on distance data (y values) are removed which occur between this x-axis range specified. Multiple filters can be
added to operate using different x-axis ranges as shown below:

8.2.6 Median
The Median filter is a nonlinear digital filtering technique, often used to remove noise. The only parameter is the number of points which
needs to be an odd number between 1 (no change to data) and 99.
To demonstrate, using a window size of three with one point immediately preceding and following each point, a Median filter will be
applied to the following simple 1D signal with a window set of 3:
x = [2 80 6 3]
So, the median filtered output signal y will be:
y[1] = Median[2 2 80] = 2
y[2] = Median[2 80 6] = Median[2 6 80] = 6
y[3] = Median[80 6 3] = Median[3 6 80] = 6
y[4] = Median[6 3 3] = Median[3 3 6] = 3
i.e. y = [2 6 6 3].

8.2.7 Moving Average
Moving Average filter works on input sampled data using a sliding fixed size window of number of data points. The first point of the
Moving Average filter is obtained by taking the average of this initial fixed window of points. Then the window is shifted forward such
that excluding the first point of the series and including the next point following the original subset in the series. This creates a new subset
of points, which is averaged. This process is repeated over the entire data series. The plot line connecting all the (fixed) averages is the
moving average. A Moving Average is a set of data points, each of which is the average of the corresponding subset of a larger set of
datum points. The only parameter is the number of points which needs to be an odd number between 1 and 99.
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8.2.8 Savitzky-Golay
A Savitzky–Golay filter is a digital filter that is used to smooth sampled data such that to increase the signal-to-noise ratio without greatly
distorting the signal. This is achieved, in a process known as convolution, by fitting successive sub-sets of adjacent data points with a
low-degree polynomial by the method of linear least squares. Using this Un-weighted Smoothing filter, there are two parameters to be
adjusted by the user. The Polynomial Order and the Number of Side Points. The number of side points MUST be greater than or equal to
the order of the polynomial.

8.2.9 WindowedFir (Windowed Finite Impulse Response)
A smoothing window is a mathematical function that is zero-valued outside of some chosen interval. When another function or waveform/
data-sequence is multiplied by a window function, the product is also zero-valued outside the interval, all that is left is the part where they
overlap, the “view through the window”.
Within the filter parameters, there are different types of Smoothing Windows that can be used. Below is a list of the available smoothing
windows.
1.

Rectangular

2.

Hanning

3.

Hamming

4.

BlackmanHarris

5.

ExactBlackman

6.

Blackman

7.

FlatTop

8.

BlackmanHarris4Term

9.

BlackmanHarris7Term

10. LowSidelobe
11. BlackmanNuttall
12. Triangle
13. Kaiser
14. DolphChebyshev
15. Gaussian
For Lowpass and Highpass of the WindowedFir, the following Filter Parameters are available.
•

Number of Coefficients

•

Cutoff Frequency (Hz)

•

Smoothing Window

•

Window Parameter (With a Smoothing Window of type 13 – 15).

For Bandpass and Bandstop of the WindowedFir, the following Filter Parameters are available.
•

Number of Coefficients

•

Lower Cutoff (Hz)

•

Upper Cutoff (Hz)

•

Smoothing Window

•

Window Parameter (With a Smoothing Window of type 13 – 15).
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Windows Parameter specifies Beta for Kaiser, Main-to-Side lobe ratio for DolphChebyshev, Standard Deviation for Gaussian. Large Beta
results in narrower smoothing window, Standard Deviation (if 0 or less then default value will be used which is 0.2) and Main-to-Side
lobe height ratio is in decibels.
NOTE: Please see more information about filters in built-in Help (Press F1 in DAS™ application).

8.3 Using Advanced Edition – Auxiliary Plots
NOTE: Some of the features discussed in this manual are available in DAS™ version later than 1.0.0.0. Please check for any available
updates in DAS™.
DAS™ Advanced Edition provides functionality of applying a selected operation to a plot to create an auxiliary plot. Some auxiliary
operations can operate on single plot or on two plots. The operands, i.e. the
plots selected from a list for a given operation which may require one plot
operand or two. More than one plot can be selected using CTRL Key + Left-Click.
Order of selection of more than one plot is important in some operations such
as Subtraction or Division. The selected plot/s are not needed to be Active to be
selected as operands.
When a user click on Operations in Auxiliary Plots group in the ribbon menu,
the following dialog is displayed.
Various plot operations are available for a selected plot (some operations
require two selected plots) in Auxiliary Plots Operations dialog.
•

Curve Fit (Linear, Polynomial, Exponential, Power etc.)

•

Differentiate

•

Integrate

•

Area Under The Curve

•

Normalize

•

Quick Scale

•

Scale

•

Clip

•

AC/DC Estimator

•

Add

•

Subtract

•

Multiply

•

Divide

•

Statistics

As an example the following shows a curve fit operation on a selected plot.
When OK is clicked, the Operations dialog closes and creates a curve fit
plot line (in green colour) with textual output in the main window showing the
parameters values and quality of fit result as follow:
Some operations do not create a graphical output or plot and display textual
information only which needs to be copied to clipboard before closing textual
information dialog box.
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As an example of two-plot operation, the following shows a subtraction
operation (red colour) between original plot (black colour) and clipped (y
value between -0.3 and 0.2) version of original plot (green colour). Two plot
operations requires that both operand plots have the same x-axis range.
The user can delete an Auxiliary plot by selecting it in Active Plot Selector
Grid and pressing Delete key or by Delete menu in Auxiliary Plots group in the
ribbon menu.

Auxiliary Plot Operations:
Curve Fit: This option provides various types of curve fitting methods such as
Exponential, Linear, Gaussian, Polynomial etc. All curve fitting operation require a source plot along with x-axis range selected by user
either by entering values in Start at X/End at X text boxes or by moving vertical cursors in small plot view window as shown in figures
above.
Differentiate: This operation requires a source plot along with x-axis range selected by user either by entering values in Start at X/End
at X text boxes or by moving vertical cursors in small plot view window. The output is differentiation curve of the source plot. Textual
information is also created which can be displayed by Double-Clicking the auxiliary plot entry created in Active Plot Selector Grid on the
lower-left corner of main window.
Integrate: This operation requires a source plot along with x-axis range selected by user either by entering values in Start at X/End at X
text boxes or by moving vertical cursors in small plot view window. The output is integration curve of the source plot. Textual information
is also created which can be displayed by Double-Clicking the auxiliary plot entry created in Active Plot Selector Grid on the lower-left
corner of main window. The textual information includes Area Under The Curve as well.
Area Under The Curve: This operation a source plot along with requires x-axis range selected by user either by entering values in Start at
X/End at X text boxes or by moving vertical cursors in small plot view window. The output is only textual information and an annotation is
also created in the main window showing Area Under The Curve value and input x-axis range.
Normalize: This operation only requires selected source plot. It uses calculated average and standard deviation to create normalized plot.
It creates some textual information as well.
Quick Scale: This operation only requires selected source plot. It uses calculated average and standard deviation to create normalized
plot which has range of y values in [–1:1]. It creates some textual information as well.
Scale: This operation only requires selected source plot. It uses calculated scale and offset to create scaled plot which has range of y
values in [–1:1]. It creates some textual information as well.
Clip: This operation requires selected source plot along with Lower and Upper Limit parameters. It uses these limits to clip the plot. It
creates some textual information as well.
AC/DC Estimate: This operation only requires selected source plot. There are no related parameters. The output is textual only which
needs to be copied to clipboard by the user.
The operation calculates an estimate of AC and DC levels of the input signal data. AC level is reported in RMS value of the input signal
(data) units, for example volts (RMS) if input data is in volts.
The DC level is reported in input signal (data) units, for example if input data is in volts then this value is in volts. At least three cycles of
the signal must be contained in the time-domain signal for a valid estimate.
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Add: This operation only requires two selected source plots and uses addition to create resulting plot. It creates some textual information
as well.
Subtract: This operation only requires two selected source plots and uses subtraction (first select plot minus 2nd selected plot hence order
of selection is important) to create resulting plot. CTRL key + mouse Left-Click is used in the grid entries to select/unselect 2nd plot. It
creates some textual information as well.
Multiply: This operation only requires two selected source plots and uses multiplication to create resulting plot. It creates some textual
information as well.
Divide: This operation only requires two selected source plots and uses division (first select plot divided by 2nd selected plot hence order
of selection is important) to create resulting plot. It creates some textual information as well.
Statistics: This operation only requires one selected source plot and x-axis range selected by user either by entering values in Start at X/
End at X text boxes or by moving vertical cursors in small plot view window. The operation calculates various statistical outputs values
such as Mean, Standard Deviation, Variance, Median and RMS (Root Mean Squared). The output is textual only which needs to be
copied to clipboard by the user.
NOTE: Please see more information about Auxiliary Plots in built-in Help (Press F1 in DAS™ application).
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Chapter 9
Advanced Edition –
DataTrap II™ Synchronization
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Over view
Multiple DataTrap II™ units (minimum 2 and maximum 7) can be synchronized to get additional
measurement capacity of 16 to 56 channels of data. The units have to be setup for 5 MHz or
less sampling rate. One unit has to be setup as Sync-Primar y (or Master) and other units as
Sync-Secondar y (or Slave) as described later in this chapter.

9.1 Necessar y Equipment
At least 2 DataTrap II™ units are required. One DataTrap II™ unit will be the SyncPrimary (or Master) unit, the others will be Sync-Secondary (or Slave) units. One
Synchronization cable for each Sync-Secondary unit. If the operator use 2 units, 1
cable is required. If the operator use 3 units, 2 cables are required, etc.

9.2 Summar y of Test Process
Using the menu buttons on the DataTrap II™, set one unit to be Sync-Primary (or Master) and the others to be Sync-Secondary (or Slave).
Use the setup software to ensure that all channels are set up to be triggered by the synchronization cable. (They can also be setup to trigger
later but still with synchronized time). Set sample speed to 5 MHz or less. See more details in Section 9.6.
Connect the synchronization cable(s).
Press Next Test on each DataTrap II™. Confirm from the menu that they are synchronized, then press Start on each DataTrap II™. They are
now ready to be triggered.
Download the data from all DataTrap II™ units to the same directory for this synchronization test (“.dt2” and “.d2d” files).
Once all data has been downloaded, create group files (“.syncd” files) for the data. This is done by picking one of the Sync-Primary files,
then choosing its Sync-Secondary file(s). This creates a “.syncd” file.
Open the “.syncd” file. It will now display data from all channels of all tests in the synchronized group.

9.3 Hardware Setup
DataTrap II™ Synchronization Menu Setup
The DataTrap II™ units are user-programmed for synchronized data
collection using the push button menu on the metal faceplate. This is
started by turning on the DataTrap II™ and pressing the left arrow( ) button to start Services.
Normally, this is below the word Services on the menu, but it may have turned off to save power. After pressing this, the menu shows the 1st
service Erase Last Test. Press the right arrow ( ) button to choose other services until the option Synchronization is shown.
Press the Enter button to choose that option. Press the right arrow ( ) button to change Synchronization mode from Off to Sync-Secondary
(or Slave) or Sync-Primary (or Master). Press the Enter button to choose that mode. Press Esc after pressing Enter to go up one level in the
menu. Keep pressing Esc to get back to the original menu state that showed: DataTrapII Services Config
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Repeat this procedure for the other DataTrap II™(s) except
that Sync-Secondary (or Slave) should be chosen.
NOTE: The operator can press Esc instead of pressing
Enter to make no choice.

9.4 Synchronization Cable Setup
The cables are connected in the following way, with power either on or off.
Connect the Sync Out connector to the lower connector of the Sync-Primary DataTrap II™.
Connect the Sync In connector to the upper connector of the 1st Sync-Secondary DataTrap II™.
If this DataTrap II™ is on and in Sync-Secondary mode, it will beep and briefly show Synced on
the menu. If it is turned on later, it will show Synced briefly after powering on (if the Sync-Primary
DataTrap II™ has also been powered on). If the Sync-Primary unit is turned on after the SyncSecondary unit, then it will briefly show Synced then.
3. If there are more units, connect the Sync In from another cable to the 1st Sync-Secondary and
connect the Sync Out connector to the 2nd Sync-Secondary.

9.5 Synchronization Menu Start
Before conducting a test using synchronization, connect the cables as mentioned in Section 9.4 and then do the following:
Power on each DataTrap II™.
Press Next Test on each DataTrap II™. If the cables have been correctly connected, the SyncPrimary unit will show a three-line symbol as shown:
The Sync-Secondary unit(s) will have a two-line symbol as shown:
If the cables are not connected or one of the units has not been set correctly by the menu,
the two-line symbol will have a slash through it as shown:

Once it has been confirmed that all symbols show a correct connection and setup, press Start on all units. It is now ready to trigger and
collect data.
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9.6 Programming DataTrap II™ For Synchronization
Programming For a Synchronized Test
The trigger event from synchronized DataTrap II™ is equivalent to another form of external trigger. If the operator wants all DataTrap
II™ to trigger simultaneously, then all active channels must be set to allow external trigger. They can also be set to be triggered from an
internal trigger. The usual practice for a test with internal triggers is to set the DataTrap II™ to “External Trigger - Make” and leave the
external trigger input open. In this way, an actual “Make” event will never occur, but the DataTrap II™ will receive a trigger from other
DataTrap II™. If it fits the plan for the test, the DataTrap II™ can be setup to wait for a trigger event just on that DataTrap II™ by turning off
all modes of external trigger. The time shown for the resulting data will still be time synchronized with the other DataTrap II™.

Programming – Trigger Only From Other DataTrap II™ Units
To setup a DataTrap II™ so that it can only trigger from another DataTrap II™ triggering, program it for “External Trigger – Make” with
internal trigger turned off and leave the external trigger BNC connector in an open circuit state. Note that the chained cover for the BNC
connector for Trigger-In will not “make” the circuit, so it can remain tightly closed over that connector.

Programming – External Trigger
If the plan for the test requires an external trigger, then the operator can choose any of the external trigger choices given when
programming the DataTrap II™. It will be triggered by the external trigger or a trigger event on any other synchronized DataTrap II™.
Only one of the DataTrap II™ will be connected to the actual external trigger. The others should be set to External Trigger – Make with the
connector left tightly closed.

Programming – Internal Trigger
If the plan for the test requires an internal trigger, then the operator should first turn on External Trigger – Make. Next, setup the internal
trigger and apply it. The chained cover for the external trigger input should be left tightly closed.

Programming – Sample Speed
The DataTrap II™ must be set to a sample speed of 5 MHz or less to be synchronized.

9.7 Synchronized Data Retrieval and Analysis
NOTE: This functionality is available only in the DAS™ Advanced Edition.

1. Initial Download
With the software installed on the computer, connect the DataTrap II™ to the
computer as described in the data download section. Next, start the DAS™
software. Select or create a directory for this test where the data from all the
DataTrap II™ units will be downloaded, then download them. A screen shot below
shows the downloaded files from Sync-Primary and Sync-Secondary DataTrap II™
in a directory:
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2. Linking Synchronized Files
Once all the files have been downloaded in the directory of your choice, they have to be
linked together to create a synchronization file. The following picture shows the Hardware
tab with a Link Sync-ed Files button.

Clicking the above mentioned button, the following Link Synchronized Files dialog box
will be displayed.

3. Choosing Sync-Primar y File
With Link Synchronized Files dialog displayed, browse to the directory where data files
have been downloaded. If there are Sync-Primary synchronized files are downloaded
and has not been linked yet to any Sync-Secondary, the Unlinked Sync-Primary Files
dropdown will be enabled and those Sync-Primary files will be available in the dropdown
Unlinked Sync-Primary Files (Total = x) as shown below:

After selecting a Sync-Primary file, Choose Sync-Primary File button should be enabled.
Click it to choose the selected Sync-Primary file.
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Sync-Primary file entry is displayed in the text box below with full path visible.

4. Choosing Sync-Secondar y Files
Once the Sync-Primary file has been chosen, clicking Next shows the operator a
list of files that were downloaded from a unit that was set as Sync-Secondary and
also connected 1st in sequence after the Sync-Primary unit. It also uses the internal
calendar/clock of each unit to show the difference between the times when the Start
button was pressed on each unit. The date/time can be viewed by pressing the Info
button on the DataTrap II™. Typically, this will be 0-60 seconds for data sets collected
at the same time and will be much smaller than other possible files. If a DataTrap II™
has been used with a computer that is set for a different time zone, then time stamps
will be farther apart.
Select a Sync-Secondary file in the dropdown. This makes Choose Current SyncSecondary File button enabled.

After clicking the Choose Current Sync-Secondary File button, first Sync-Secondary file
entry is displayed in the Chosen Sync-Secondary Files text box.
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If there are additional related Sync-Secondary files available, user can select and
add them too. In this single Sync-Secondary file example, we do not have any more
file to add. Now the Finish is enabled. Clicking Done or Finish button will create the
“.syncd” file and a message is displayed as shown below:

5. Viewing Synchronized File
To open a “.syncd” file, user can use the usual methods to browse to the directory where the “.syncd” file
created. That is either using or check-marking “.syncd” file type on the Open Data Files tab and clicking
Next button.

The following will be displayed:

Then select “.syncd” file and click “Open” button or double-click the file name. This
will open the Sync-Primary file and its linked Sync-Secondary files with all their plots
as shown below:
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A Sync-Primary file is indicated in left-side graph tree by (
file is indicated in left-side graph tree by (

) and a Sync-Secondary

)

In addition an “All Syncd Graph Channel” node is created in Sync-Primary file with an
“All Syncd Graphs” node under it. This graph node displays all original plots (related
to Sync-Primary and Sync-Secondary) on a single graph. This gives an overall picture
of all the plots in the related syncd data sets. Limited operations are also possible on
this graph node plots such as calculating VOD for an active plot, calculating Delta X
on one or between two plots and calculate Delta Y on one or between two plots (if
they have same units and quantities). Working on individual channels are strongly
recommended.

6. Definition Of “Time=0”
All the graphs drawn are synchronized to a common “time=0”. This is normally set as the trigger time of channel 1 on the Sync-Primary
unit. If channel 1 was not triggered, it is the Stop time for channel 1 on the Sync-Primary unit. Events at the same time from different data
sets were recorded at the same time.
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10.1 Contacting MREL
MREL Group of Companies Limited
Data Acquisition Team (DAS™) Support Team
5-779 Sir John A MacDonald Blvd.
Kingston, Ontario K7L 1H3
Canada
Toll Free
Tel: 		

+1-877-544-MREL (Canada/USA)
+1-613-545-0466

Email:

das@mrel.com

Support:

www.mrel.com/contact.html

MREL looks forward to providing you with assistance.

10.2 Emailing Data Files to MREL
For DAS™ Data Acquisition Suite software, the user with need to send the following files for analysis of the user’s data. In this example, the
users file name is Myfile.

10.2.1 DataTrap II™ Data/VOD Recorder
The following files will be needed:
•

Myfile.dt2

•

Myfile.d2d

•

Any related files with the same name such as Myfile.xml and Myfile.zip if applicable

10.2.2 MicroTrap™ VOD/Data Recorder
The following files will be needed:
•

Myfile.mcr

•

Myfile.raw or myfile.cmp

•

Any related files with the same name such as Myfile.xml and Myfile.zip if applicable

10.2.3 HandiTrap II™ VOD Recorder
The following files will be needed:
•

Myfile.ht2

•

Myfile.raw

•

Any related files with the same name such as Myfile.xml and Myfile.zip if applicable
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